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adaptive-security-appliance-asa-software/products-installation-and-configuration-guides-list.html
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interface $ifname
key @keyname
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#if (StcpMssMinimum == "true")

sysopt connection tcpmss minimum $tcpMssBytes
#else

sysopt connection tcpmss $tcpMssBytes
#end

e B, Rl FlexConfig Xt 5 gt AUFE AN StepMssBytes 25— NI, (1
AT LUELREAE #else 1T HHHBEANAS L
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ZETE, MEEMBEFHEREE

ARG SRR G A RN R — I ZAME . 10, F8 1 09 288 06 G 2 %o 5 A AT A 2
IP Ml . ke, RGA5E $SYS FW INTERFACE NAME LIST fithft h4% L 4 BRI 51) %

AT PLA AR B ZAME B SO G i, T5E W SCARXT S enablelnspectProtocolList A BA
5 Z AR

AT g [R5 1) 2 AR ROl A AN E K. B, EERUcRiEam 4 T ig EnE
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Rl A IR AR AL BR IR — SR A & . il F35E ) FlexConfig
Default_| nspection_Protocol_Enable {i F #foreach ¥ >k ki JJj enableInspectProtocolList X % Jf-4b
BEAME.

policy-map global policy
class inspection default
#foreach ( $protocol in $enableInspectProtocolList)
inspect $protocol
#end

FEMORGI R, A YO REAMIE /3 L4, Sprotocol 28R, ARG TE ASA inspect i 4 Hi il F %748 7
U ARSI G 1 FEIXFME O, A BN Sprotocol 14T AFR . AL FHEENE R
e, BUNEBAA RN R RGUH A BCA 1ZAL w . H, DI FHR NS L N

$enablelnspectProtocolList.

F 4T #foreach Fl #end < MG JJ1AXAS, H 2| $enablelnspectProtocolList H A7 Fl 4= [HIME -

ZNMETE, EEBEAFRIRYER

AL ZAME ARG, AR A . B, FE X netflow_Destination AR
GRLAT 3AME, Sy BIACREE N 4 FR. F AR 1P MubL A UDP 35115

LU 7 2 SO G HAT W (A A0, A R AR AR BT

fUTHT get JTIRARFIIX LS B o (EXS RAFRTIAR RN get(n), I n B X R iR S 0 IR
TG BIMESCRXS SR 1 IT AR 51 H AR IR A2

%41, Netflow Add Destination X§ % F LA F 17°Kf netflow Destination " (1] 3 MEZSIIE] ASA
flow-export 4.

flow-export destination $netflow Destination.get(0) $netflow Destination.get (1)
$netflow Destination.get(2)
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TR R, RS FlexConfig % 4 4 2% (13 NS 95 I $netflow_Destination (15— i
., RJE%IN get(0). (HA4 7] LLE %4 $netflow_Destination.get(1) A1 $netflow_Destination.get(2) #i
LHENZA .

BITEERNZ METE

FHEe R G AR IR N —MER . XA ARG LT MAP, %l
$SYS FTD ROUTED INTF MAP LIST. B D mshR b8t R s Ch TR, 3
THAT) -

[{intf_hardwarare_id:GigabitEthernetO/O, intf ipv6 eui6d4 addresses=[],
intf ipv6 prefix addresses=[], intf subnet mask v4=255.255.255.0,

intf ip addr v4=10.100.10.1, intf ipv6 link local address=,

intf logical name=outside},

{intf hardwarare id=GigabitEthernet0/1, intf ipv6é_eui64 addresses=[],
intf ipv6 prefix addresses=[], intf subnet mask v4=255.255.255.0,
intf ip addr v4=10.100.11.1, intf ipv6 link local address=,

intf logical name=inside},

{intf hardwarare id=GigabitEthernet0/2, intf ipv6é_eui64 addresses=[],
intf ipv6 prefix addresses=[], intf subnet mask v4=, intf ip addr_ vi=,
intf ipv6 link local address=, intf logical name=},

{intf hardwarare_id=Management0/0, intf ipv6 eui64_addresses=[],
intf ipv6 prefix addresses=[], intf subnet mask v4=, intf ip addr_ vi=,
intf ipv6 link local address=, intf logical name=management} ]

e LRy, B 4R EME R, RN OEARE— MR e ER. FIW, intf hardwarare id
ST VR FRJE Y AR, FERFIR [R5 41 GigabitEthernet0/0 [1)7-FF 5

RIS T WA EATE , DR S AR BOR A P . (R OE 75 20K SR V' A AR I 2142
EAMT, DR ER R M.

B, 1S-1S o' 75 B b2 L B ALK ASA isisir 27 25— HAF 8 A Rz 0. (H4&s ] L
i i R R A RRE NAZAE . DRI, A 2 e TR e 1 S ﬁﬁiﬂ%*fln SR AN A 3
T2 AR AR O, Tilse LT ISIS Interface Configuration HJ FlexConfig i ] ik EAE A B Y
if/then &5 M KIAT ICERAE . 76 FHIARAS T, W] LG 2] #foreach AN fiy - 23K B A48 LIS N 48 2
$intf B, SR)E #f 1B DI KTLSS (Sintfintf logical name) F1H] intf logical name {8, JfH. 1R
ZAENL T isisIntfList Tﬁﬁi)\(ijg@?%qj%)\(m A, WEEH intf hardwarare id {H

(Sintf.intf hardwarare id) fi \N#z 4. 75 24w isisIntfList 48 & LAS N2 4E L ECE 1S-1S 42
FITR) 4498 o

#foreach ($intf in $SYS FTD ROUTED INTF MAP LIST)
#if (SisIsIntfList.contains ($intf.intf logical name))
interface $intf.intf_hardwarare_id
isis
#1if ($isIsAddressFamily.contains ("ipvée"))
ipv6é router isis
#end
#end
#end
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PPALRE 23R [l A AR B Pl ] 507 O B MR FlexConfig X5, 200 Bk T A BR A AT 1T
AR IIR LA, AT ABERAE . BEJS rIR 200 B Be 4 2 — FlexConfig M,  PRAF %5
WML —BEa, DRAFIZHRENG, RSB MM E . TR s br R . 7T LIS
FRGESCA, 2 Ctrl+C B, R JrRe i RS U 20 SCASSCAE 0 e

Y

ER (UAZDHIE FlexConfig #8211 %, BN E NS EATMA BRI HIGR 2. EORIEFT S 1%, 75
RAFIN S, 185 M FlexConfig Helig IR 1% FlexConfig X%, SR 5 IRAF1X RIS .

i, w7 LAREELAR FlexConfig X4

Following is a network object group variable for the
IPv4-Private-Al1-RFC1918 object:

$IPv4 Private addresses

Following is the system variable SYS FW_MANAGEMENT IP:

$SYS FW MANAGEMENT IP

Following is the system variable SYS FW_ENABLED INSPECT PROTOCOL_LIST:
$SYS FW ENABLED INSPECT PROTOCOL LIST

Following is the system variable SYS FTD ROUTED INTF MAP LIST:

$SYS FTD ROUTED INTF MAP LIST

Following is the system variable SYS FW _INTERFACE NAME LIST:

$SYS FW_INTERFACE NAME LIST

IERT G T T AR R 7R C THE AR L, W T 847D -

###Flex-config Prepended CLI ###

###CLI generated from managed features ###
###Flex-config Appended CLI ###

Following is an network object group variable for the
IPv4-Private-Al1-RFC1918 object:

[10.0.0.0, 172.16.0.0, 192.168.0.0]

Following is the system variable SYS FW MANAGEMENT IP:
192.168.0.171

Following is the system variable SYS FW ENABLED INSPECT PROTOCOL LIST:

[dns, ftp, h323 h225, h323 ras, rsh, rtsp, sglnet, skinny, sunrpc,
xdmcp, sip, netbios, tftp, icmp, icmp error, ip-options]

Following is the system variable SYS FTD ROUTED INTF MAP LIST:

FlexConfig SRA%
|



FlexConfig 8% |
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[{intf hardwarare id=GigabitEthernet0/0, intf ipvé6 eui64 addresses=[],
intf ipvé prefix addresses=[], intf subnet mask v4=255.255.255.0,

intf ip addr v4=10.100.10.1, intf ipvé6é link local address=,

intf logical name=outside},

{intf hardwarare id=GigabitEthernet0/1, intf ipv6 eui64 addresses=[],
intf ipvé prefix addresses=[], intf subnet mask v4=255.255.255.0,
intf ip addr v4=10.100.11.1, intf ipvé6é link local address=,

intf logical name=inside},

{intf hardwarare id=GigabitEthernet0/2, intf ipv6 eui64 addresses=[],
intf ipvé prefix addresses=[], intf subnet mask v4=, intf ip addr vi=,
intf ipvé link local address=, intf logical name=},

{intf hardwarare id=Management0/0, intf ipv6 eui64 addresses=[],
intf ipvé prefix addresses=[], intf subnet mask v4=, intf ip addr vi=,
intf ipvé_link local address=, intf logical name=management} ]

Following is the system variable SYS FW_INTERFACE NAME LIST:

[outside, inside, management]
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* R ACL & - G T U h 53§ ACL AR kg it ACL X L4475k MH
kPIEFIESIR > ¥R, RaAinRmy RiFEIIRNR. WSS,
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SYS_FW_OS_MODE

B HIEAE RS . AT RERME fLF5 ROUTED 5 TRANSPARENT,

SYS FW_0OS_MULTIPLICITY

BAAE L BB UL 2 218 SRR I2AT . T REMMA 45 SINGLE.
MULTI & NOT_APPLICABLE.

SYS FW_MANAGEMENT IP WA B TP Mkl
SYS FW_HOST NAME BeAs EHLA

SYS_FTD_INTF_POLICY MAP

LA VR RRAE D BT SRS R (B AW . SR e b8 e Sk
THOT IR ST Ems AR R AN IR [T A

SYS FW_ENABLED INSPECT PROTOCOL LIST | 1 i T # # fr sl [ 51 35 .

SYS_FTD_ROUTED_INTF_MAP_LIST B i e DR B3R . BRI A — 2 i e 1 PGB AT
ENITEA R

SYS_FTD_SWITCHED_INTF_MAP_LIST W BATH B I 513 . A WU AL £ — 41 S AT L C A
ENIIE R

SYS_FTD_INLINE_INTF_MAP_LIST Bk BN DU 813 . AN A 35— 41 N IDRER R I T
EPNIEA R

SYS_FTD PASSIVE_INTF_MAP_LIST

BE# BN IE LU 151 . BRSSP A
PN IEGEZEIER

SYS_FTD_INTF_BVI MAP LIST

B L RIHFRE AL LIRS (213 o BN #R 65 — 415 BVI BCE
FHR I i 44 fEL o

SYS FW_INTERFACE _HARDWARE ID LIST

W% BRIP4 FR (40 GigabitEthernet0/0) {1514

SYS FW_INTERFACE NAME LIST

W FEIEE AR (D 1A,

SYS_FW_INLINE_INTERFACE NAME_LIST

P B0 4¢3 8 ERSPAN #7280 (142 1 (V324 4 PR 8114

SYS FW NON_INLINE INTERFACE NAME LIST
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(SEBr L, IG¥ http ¥

JN#| enablelnspectProtocolList ¥ %o TEIXFMEHL T, BOKEBEBH L DU A RIC B IS % . D FHR,
IR T B 7 ) 5 ) SR e LAAAT B B URL €,  DASIZ)ifE HTTP f A 2K .
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Description

KERBISCA X &R

Default Inspection Protocol Disable

1t global_policy BRI Sk B Bl 5 4% F
W

disablelnspectProtocolList

Default_Inspection Protocol Enable
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A A Ctrl+C R LRI BB AR, 45T LR HORE I 1 SCASCA i BLEAT JE— 20 70 # e

OO L4 LA R ¥ 70:
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© MNEZEDIREAEIKIN CLI - 3K L8 Dy 7 A5 B AL o G B2 10 SRS A= 182 ) i

o H KBTS Bk
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b) 1E #E L, WIEAE T L),
o) HEEATLIMELE, FHlbExt TRBIEE, i nhBRmRIER.
d) FEZCMF A ENR B h R E L.

VRNV MBI S - Bl AL AL T 41 2 THE
e) fEAMA b richi e (1 B 2 rH KR 3

FE AR LT RR BV (10 i 2 LA AL 3 [P RO AT AR R 2 o T e 7 W] A £ JE P v S
PR TR, i kRS L FlexConfig & 3% 1 fir S HHR I B o IX e 5t nf
B 2 E 22 B X 2 iy 4 1) FlexConfig X 4 b (1 JAIAS .

pE s HFEE T RE R IE M fir 2 5 A FlexConfig Sl A2 i) iy & 2 IMAEAT Wk 35 22 57
filtn, LU Fea s & F D K& T fir2 K GigabitEthernet0/0 FiC B AMBIEHIAL o B2k 1WA Y

S FUE AR E N 00 B AN 204 2 A0 TATATHRE . 15 FlexConfig H15C 31 KL
TEAZIA ) “CLL N7 #54y

FMC >> interface GigabitEthernet0/0
FMC >> nameif outside
FTDv 192.168.0.152 >> [info] : INFO: Security level for "outside" set to 0 by default.

60 I 8 1) L e A B 1 TR Ay 2 o
s mT UIE 55 W A 14 B TP Mokt vy SSH Bk 58 itk I T-4E . {#H show running-config iy 4 7
ﬁ‘@aﬁ o
wi#, 7E Cisco Secure Firewall Management Center{# [} CLI T H..
a) P > BITIROR > IIE . AR5 SRS AR
AT e A 2 R HPIRAS R N B rh T T/ Q7 ok B AT 4%
b) A EREMPEHRE .
¢) il EUBRBAHE CLI.
d) #$¥ show 142, SRJEHEA running-config /£ 4240
e) miiithiT (Execute)

IEAEISAT FBC B s AR SCARHE o ST DB FEIC B P44 Ctrl+C, R R RS UG 281 SO A SO A e DA
LS o
KR B 2 AL U A

41 5 ML REAH S show iy 4 i A B VRIS BAGETHE B B, i iE s 1 T HAb b o 2, )
show service-policy fir &2 f it f5 B EAEH VIS 5 DhReA ¢, IF H AR IR T gt fT iic
FILINAEN ASA BLEAR MM AT 2S5 i M.

IR B GETHE RIS Fm BUP AR A (i, drrh R, SEREEAE) , IRCE RTREAAL
EBRA S WG FIE R B AR AR S R i e, ARG E S D A A i,
NAT si1j ] R0 AT B i 2225 57 sl i, A4 REXT SN R R -
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B #5058 Fexconfig B & tn e

R LU SSH 23 iifi sl & B rpy CLI TR AE 1 show fir 2

(HIE, R EAE T show T JoiE B BBl CLI 3R AT, IR 245 B % 1 57 SSH 4%
AR X 4. £E CLIH, A LR @81 LIEZ KT CLI FhaE NHRFA EXEC B, f&0T LA7E
PEAR s N IXLEABE SR show fiT 4

> system support diagnostic-cli

Attaching to Diagnostic CLI ... Press 'Ctrl+a then d' to detach.
Type help or '?' for a list of available commands.

firepower> enable

Password: <press enter, do not enter a password>

firepower#

T R& 4% A FlexConfig BC & A9 TH &E

QR e T B M B A# ] FlexConfig FCE I —HRCE 44, WAl FREF MR ZALE . MRS
43 FlexConfig HiME n] RE AR AT B L&

BTENRZECE , 1 6IESHN) FlexConfig %t %2 DL Ik s UM il & v 4 .

FHia Z |l
R 1 it TSI SR B A R P 3 A B L, TS AT DL T A

1 Tﬁﬁ@ﬂﬁ?ﬁ%, ﬁﬂﬁj% FleXCOl’lﬁg ﬁ%ﬂ]% ’ %‘ 29 ﬁ*ﬁﬁﬁo ﬁﬂ%’ﬁ ###CLI generated from managed
features ##4 w7 ELEVE BRETT A8 fir 2 LUMER FlexConfig Xf R (M i A %, #5875 M FlexConfig
T PR MR 5, CRAETT HEFE 2

2. U\FlexConﬁg HERE IR T 5, RAEEE R, AR PRI L E . WIER #44cLr generated from
managed features ###%ﬁﬁ?@ﬁﬂ<€2€?ﬁﬁﬁﬁE@ﬁ%&%ﬁﬁ??ﬁiﬁﬁé?, mUiéﬁﬁiﬁﬁﬁﬁtfﬁf?qinMU&%@ﬂ%io

UK

LR PR EUIpOR IO E A%, IEFEM R > MR ER IO FlexConfig X4 .

TR SEAS D B AT AT LU BRI A L BB clear a4y, MIMEA tbdr 4. i, fiE XK
ISIS_Unconfigure All X§ Gt — N rT AR PTE 5 1SIS AH G BC & w2 1) iy 2

clear configure router isis

WERIL T REBAT clear fivS, WU SEAE AR SR ) -2 1) no T2 #iltan,  T5E L
Sysopt_basic_negate X ZORHI ER 3 3 T ¥ Sysopt_basic % L E (1 fir 2

no sysopt traffic detailed-statistics

no sysopt connection timewait
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N
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{5 FlexConfig S UMM PR AN 77 L C B dr 2, WIAE MR 58 105 J0 7 O B 73 U4 % 045 TR SR
A2, WK FlexConfig HBS IR T 84 A AR vees BIECE LT, 8 MRS T BRI A % . AT
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AE. IXnlHESs S A MY FlexConfig v 4 #IMACE AL Halkd. e g0n, BIIEER
WL FH I 2K 0 BC B 2 FlexConfig XM %o TETHKAT )G, K #r FlexConfig SIS AN 4 o

CEA ] FlexConfig REFEI ) A TP 32 FEE DT EFIDRERS, #5UIt F] FlexConfig B8t Hi 1152
HIIfe. MERZHIGOUTY, I FlexConfig B & S 7R THIUR RS TAE, U8R v AT
EAERLEEOUR, A S a2 il R S EBE 8. ASSCRERINAE GUI H FlexConfig 1L
it

\}

AR WRTR TASCRHE TR DD RERC ., AT A LR IR

i

HIE 1 MR FlexConfig, WM ] FlexConfig it & I ZhfE , 2 32 TR,
PR 2 MEBCH SR E DIRe b i E .
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A BRI RS T IZARAS KBTI RES IR

FlexConfig 7= 51

PLF 248 H] FlexConfig ff)—247R 41

gn{ry BC & A5 H4 B (8] 1733 (ISA 3000)

I R] B (PTP) & — RN 1] [ 2 Wil T T-7E 2 T B 6 1) W 206 v )20 8 R B 2 (R I k. S
VLA IR B AT AR R BEEANRRUE P o WML D TR A ) R S ek, i Hsad 5
TR GE, D AT SR> (K17 58 AR BT o

PTP ARGt — N An N R SE, 5 PTP WA A1E PTP B4 141 A . PTP W40 2 LK) e 4
T RS B I, AR PTP WA S MR AT B L % H 2% A0 LA FE At 4 it ¢ 4%

AT DLOKE BB AR W BB W . B R B AN S S S PTP BRI E 2D . g A
BEAK A ] PTP BROARC & SC:, 4 PTP W4 LA g o

BLE PTP Wi, FFENE—RIZIT & E L — Mg 'S . ik, nTRIRCEZ A PTP Ik, AR5
FFANE PTP 5 #4 I B e e 388 PTP B4
FriaZ /i

i 5 Vg AR (¥ PTP I B B G L Rk 5o bl B PTP 3k 50 100 34k, 58 AR gl it
WIRLEHE 1 RIIA B (1) PTP I 4

L& PTP it & 145
« WLIh AR IR ISA 3000 4 EANH A
* JRL PTP {USHFALER PTP I K.
* PTP {X A F T IPv4 %%, ANHT T IPve M4,

© WUBE LUK PO 3 SRR PTP R, CiR R M s 2 MR AL bt o A BRI TR
Etherchannel # 11 #f4 fE 0142 11 (BVI) ST AA] ToAth i F00 822 U3 AS SCRFIERROAS .

o RInAHE D F EAE MM PTP Bl s, WISZEE VLAN 7410 L) PTP %

o DAIIAAAR SRV PTP Bl (il id 3645 . PTP y & 1 UDP H A5 1 319 A1 320 LA A Hbx IP Hudik:
224.0.1.129 riH, DRI Fo v MO BB PR AR ART 5 i) 2 S0 DU 44 I A 285

o TR BT K EERIN, A4 PTP 4% 40 5 T AHAR % th: bah, Wi 2 PTP (945 I A AE A
A, NS % L E NN IGMP ¥4 224.0.1.129., i S sigs L2 MR LB, )
ANELE I E I IGMP 414541 .
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Nil

B

s ERsw et iy (A 30000 [l

UK

. ) AR S, A E IGMP 4.

AT, BUS AARES H. s, sFFRaryEE . (AR R , BN E
LU 224.0.1.129 IGMP 4. & TGRS & A NN IGMP 4., {H A4 bt ) PTP
e B KA IGMP I TS R 2 8.

XSG E PTP 5 & B AT IR .
iR i NN RN PTP I8 D REPE 4 FR, B, GigabitEthernetl/1,

a) %P E (Devices) > & EIE (DeviceManagement), I HawH k% .

b) sl

c) L HIBHREH > IGMP,

d) ¥ EF4RER R R IEAE.

e) siiifMNIALE (Join Group)s

0 S R, ARJSTE RN IGMP IINESE G HE, FUE DU IR, AR5 S RE

* 0 (Interface) - M 1) PTP I HMALFL
* JIA4H (Join Group) - s ili + DA BT A R 250 52 o AL il 224.0. 1 129 KA TS
ERCE A O, W EEERIES S . GES I AE R 45
X BE % FAFANIET ) PTP I i adar b OV EE 53 oD B
g) fii “Bih” (Routing) H{ifi_ERTF (Save).
B4 FlexConfig XJ %, LAME4 R A H PTP BLAAER D EJR ] PTP.

DL N RS O AL B AR & W% BT 7] PTP B Bh 0 32 IS AR R . i RAE AR (R B4 A T
AR, ST E A F A A QP . B, WREAERS AR B F{EH
GigabitEthernet1/1, {Ei%#% C fil D L /1] GigabitEthernet1/2, {Lix#% E A F b [F] W4 ]
GigabitEthernet1/1 F1 1/2, N#FF5 3 ANl FlexConfig X%, Bl J5id 75 2 3 A ¥l ) FlexConfig
Felg CHAE T — 2Tl

a) EFEITR (Object) > &K EIE (Object Management).

b) M HzkH % F FlexConfig > FlexConfig ¥t % (FlexConfig Object).

¢) Hiidifhn FlexConfig %1% (Add FlexConfig Object), Bi'& LA FJEtE, AR5 AR TE (Save).
* Name- X% 4 %% U1, Enable PTP.

* #8& (Deployment) - X (Everytime). EALTEREANIRE AL ILACE, DAE R ILORKE
M ERAS

* A (Type) - R ENEFIN (Append). X482 fE HRSCRF DI RE R fir & Z Ja i ki%
BB o TP AT ORAEIX 28 i & 2 T C B2 1 P B BT A A e AR B

* JHRIEX (Object body) - fEXTZIECH, HEANAEREANH 7] PTP B &80 L4 /L E PTP
4. @i, PTP 3K 10 145 HE & A GigabitEthernet1/1 & 42 1 BT 5 1 iy &
T
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B ot @ i ik (1SA 3000)

ptp mode eZetransparent
ptp domain 10
interface gigabitethernetl/1

ptp enable
WX B ST AR s
Insert v Deployment: Everytime Type: Append

ptp mode eZetransparent
ptp domain 10
interface gigabitethernetl/1

ptp enable

123 {E FlexConfig & 4 H A Fl 44 1 4%

WA TR PTP B AN [R5 B T 2 FlexConfig %%, TG 204 REAN T GG F it g
FlexConfig 5, JFARHE i LENCE A R IX LU S o IR B a6 . X RFAL B AL LU TR

1B
w

a)
b)

d)

L% > FlexConfig.
Ml ETIE SRR (New Policy), =03 W1 I FlexConfig HEME N /M BL4y (BC 0 E4) HAR 4,
D L5 G 12 SR s

CEQUALHRRIANSIN , S22 S i 44 TR VEHE A I 46 40 LA s
E FL 3t User Defined SO Hi# PTP FlexConfig 4%, AU Al > 4 LA DB ems o
X 5 I A 0 1 BT SE AN Flexconfig (Selected Appended FlexConfigs) 4115 H

-2 Selected Append FlexConfigs

# Name Description
1 Enable_PTP Qw
R RTF-

ARG ACKE AT H AR B /) BU2a M, 3 iy “ORA77 (Save) N ISR % 53 B (Policy Assignments)
BERIF L B34 T 7 B
RS BCE (Preview Config), SRJE7E T S X B AE Ik HE— A C o BCH

RS R IL BB AS TR E CLI Y . 31E M PTP FlexConfig X % AE il ¥ iy 2 e K s
TIEM . XU AT EE R s TR, RS E BE T4 T BE AT A 2L i o8 o A
4. Xt PTP fr 4, ENAZAE B F1 A 2%:

###Flex-config Appended CLI ###
ptp mode eZetransparent

ptp domain 10

interface gigabitethernetl/1
ptp enable

R4 B
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safaTad e A RS R 2 w32 5% 15A 3000) ]

T4 ©0F5 FlexConfig Mg 3 ACLh &, RIS IR e 84, DUR IR AT 2% FlexConfig 1)
. fidiaksE (Proceed) DIARSETSE .

FERRE eI e, Rn] DR A g Sl s P B B A . W R B8 R, X w5 S
B B0 I UG, 2 30 DL

HIBS G %A LKL PTP iLE .
M SSH sl & &G 2 5 W &, if PTP ¥ & :

> show ptp clock
PTP CLOCK INFO
PTP Device Type: End to End Transparent Clock
Operation mode: One Step
Clock Identity: 34:62:88:FF:FE:1:73:81
Clock Domain: 10
Number of PTP ports: 4
> show ptp port
PTP PORT DATASET: GigabitEthernetl/1
Port identity: Clock Identity: 34:62:88:FF:FE:1:73:81
Port identity: Port Number: 1
PTP version: 2
Port state: Enabled

PTP PORT DATASET: GigabitEthernetl/2

Port identity: Clock Identity: 34:62:88:FF:FE:1:73:81
Port identity: Port Number: 2

PTP version: 2

Port state: Disabled

PTP PORT DATASET: GigabitEthernetl/3

Port identity: Clock Identity: 34:62:88:FF:FE:1:73:81
Port identity: Port Number: 3

PTP version: 2

Port state: Disabled

PTP PORT DATASET: GigabitEthernetl/4

Port identity: Clock Identity: 34:62:88:FF:FE:1:73:81
Port identity: Port Number: 4

PTP version: 2

Port state: Disabled

anfar e R B RS B B B S AE 1455 7% (ISA 3000)

fny DUE FH AR 55 2, 300 5 7 BT P B P) 4 A 4 I 0 2 DBl o SCRp IR 10 R i i 11
GigabitEthernet 1/1 A1 1/2 L& GigabitEthernet 1/3 F1 1/4. U1 R4 2 CEF IR MRS,
HZE LA (GigabitEthernet 1/1 £ 1/2) SC I35 8K o

Jet RVREAT 55 B IS, I R AR X ez LU0 2 (B (38 1 A3 . FTD CLI 2% R AL TR RS . A
IR KEGThAE, DA A DR 1 T A SO VR I e B2 PR XA

7F CLI #5458 SSH £:i5 7, 1 i} show har dwar e-bypass iy 4 DL IE 1 IR A .
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B ot i ins & B shiE 55 5% (1ISA 3000)

T2
SR 55

o DT LA R AER— R

o MR U BUCHLI B NS LT o SRR S B0 5 1
ST P 130 5 44 8 60 S 00 O BB 0 55 00 ke A0 TCP 5
BB, BB, ISA 3000 2L I TCP JEBERIBIAAT 515 (ISN) 5 HBaHLG 5 .
PSS BT IR, 1SA 3000 THOL THCRES sl AL THHHUTIG o B S i MBI EAN 95

FEFER, NI EERTE N TCP 2. RMEEEH] TCP FPo 5 BibLL )G, KELd TCP ERCR thil
SEHPTENT, PR BERSAE D4 ) 2 1 I 5 A1 o

UK

FIE1 fl# FlexConfig X% LA H H 35
a) EHEMR>WREE.
b) M HzkHiEF FlexConfig > FlexConfig ¥t % (FlexConfig Object).
¢) Hiidifhn FlexConfig ¥t % (Add FlexConfig Object), Bi'# LA FJEtE, AR5 AR TE (Save).

* Name- X% 4 %%, 5141, Enable HW-Bypass.
 #BE (Deployment) - L HFE X (Everytime). BAERN S Th AL IECE, DA

(RN
« KA (Type) - L ERIAEMI N (Append). XUy &2 HESCREFNThRER I a2 2 Ja dl Rk ik
Ealf7hE
. XT?RIEi (Object body) FEXTGIESCH, BENJS H A S5 i A d5 e 2. Billn, wASa]
e 198 10T 75 1 i 2 -

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

TG E SO AR B :

Insert » Deployment: I Everytime v | Tvpe: | Append -
hardware-bypass GigabitEthernet 1,/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

1% 2 % FlexConfig Mg 45 LA AL A 13 4% o
a) EFIZE (Devices) > FlexConfig.
b) AidiEREEE (New Policy), o U1 B4 FlexConfig $EIE N /3 lcss (5O 0B HbRK K,
W) I 5 G 12 TS

FEGEBT SRR IR, 335 75 A S i 44 AR TEME R F AR BE2% 70 T 45 SR

. FlexConfig SRHE&



| FlexConfig %%

©)

d)

safaTad e A RS R 2 w32 5% 15A 3000) ]

75 H 3% 11 User Defined 3432 o ik £ £ 5% % FlexConfig % %, SR J5 st > 4 Hs n 3 5w o
I 5 S 4 75 0 B B 1 M An Flexconfig (Selected Appended FlexConfigs) 4141,

B Selected Append FlexConfigs

# Name
1 Enable_HW-Bypass
HiliRTE.

W A BT H bR esh sems, i s “URA7” (Save) NIl IR B& 43 BL (Policy Assignments)
BRI BT 20T
MR ECE (Preview Config), SRJ57E TN TEHEFIE R — A E 0B B o

RGLE A RO B BCE CLI P . 56k A 5% % FlexConfig X %A il i) i 2 ikl
KA IEM . XLEAETRE S RN SR, BT R, RIESF BRI FEA DI Re pT AU LA s
V5 A1 TR S I L S S R S K VAE R Sl Y R I TR T o

###Flex-config Appended CLI ###

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

P3N

T4 CU0Fs FlexConfig SEBSrBL2h £, NI IS IR 2 e B30 8245, DURIR IS K FlexConfig 1)
/. fidiaksE (Proceed) DIARSERSE .

FERRE eI G, Jn] DR A P Sl s P R T A . R R, X R . WS

N

B JAIE A S, 5 2 30 DT,

T—%#ita
D AR EET Bl P E A 55 s s TR HOGH, Wi 2200 A4S FlexConfig X 52

WG, TERE— A E— XS INE] FlexConfig Sl mf 38 Bk, LA IF el R ST, ik
ity ZEAE B Ja MBI FlexConfig SRS H MR IZAT 5. WG Tah A SeAT, R B EE %L

« ASETEIESGT, K UE U A B L, ARG RO A O AN T I 84T

hardware-bypass manual GigabitEthernet 1/1-1/2
hardware-bypass manual GigabitEthernet 1/3-1/4

© T RTBIRHSEE, P E LUR AERA 4

no hardware-bypass manual GigabitEthernet 1/1-1/2
no hardware-bypass manual GigabitEthernet 1/3-1/4

>

in
H

OB H . R, A8 I T3l Jr iy ZELe HAT- A0 9 B FlexConfig MR LA 8 % »

FlexConfig SRA% .



FlexConfig 8% |
. 1T %% FlexConfig 5RH&

1T #5 FlexConfig < B&

EE A KITH FlexConfig HElg A& H T3 % ECMP. VXLAN F1 EIGRP 3iH .

{1 F FlexConfig % % AR A 3 B O P R SRS G T ECMP. VXLAN il EIGRP 5% . & HL{E
AL B L UL Ehﬁaﬁizﬁwﬂi% A IRATH B O, RS- FlexConfig it
Ho (HAE, ZM ULEBLRS, BUUIEFINIZE (YR%8) (Device[Edit]) > B&H (Routing) T [ &
FHATHCE , JF M FlexConfig rhﬂﬂJllf@aﬁ BE UL A ) okng, 45 Ert S48t T8 e ms A
FlexConfig iF#2 %] UI [F3£ 3. {H)E, ‘BAS M FlexConfig HIHER TR 1 50E . 47 RITH 5 L
Fe, HSRDSE T, 41 T,

FHiaZ |l

* iR ) FlexConfig SEM& S BB (1),  MAERLIN . U S5 E /0 1 &8s LA BOR,
ERIETA AT o X3 BAT I ISR IR B % AN HEATIERS

o U1 AE FlexConfig Y H ALy it B T S -
s MR CAIRE (YREE) (Device [Edit]) > B&H (Routing) L& T 5kHE, WAL KT .

o ESCEIAN], A EIHOS BORERRE R . s EIGRP IEAS 47 K - EIGRP J# i) FlexConfig
X ZAATICE, mﬂﬁiﬁ%lﬂ’l “u%ﬂ%” (DeviceListing) -> “ 4t EIGRP” (Routing EIGRP)
FHHTICE . E th EIGRP 5k FlexConfig 1 4E4" EIGRP it & .

o S SRS Th AT TR 0 26 0 G AT AE TR B, IZEIT R IR, S TRBEN . /DB,
15 1P B TSR 2 G AR T I, 2x il MBI 250t 5, 1T bb B ) Bk 5,
{51 bb_<timestamp> _<integer> . % TR ME5 0%, 4Rk A0 B

i

$IB1 %R E (Devices) > FlexConfig, R st BT # 1) FlexConfig SIS ) #Rig (4 .
2 L ERBEE (Migrate Config).

iR B ITE)G, EBBCE (Migrate Config) Fl FlexConfig 4R%8 (Edit) LI & A AT A .
ELLURHWR, iEBEE (Migrate Config) AT ] -
WA ELF1IEH FlexConfig CLI.
* FlexConfig Hlg AT 5 AF4 FlexConfig % % Ik o
%A 4% 5 FlexConfig g Bk .

2

. FlexConfig SRHE&



| FlexConfig %%

FlexConfig 8971 £i2F .

PIE3 LT Flex BLE (Migrate Flex Configuration) X iGfE T, EFELE 1 HITHICE &S, AR5 stk
E (OK).
TR S BoR TS E . TG, S EEENRE R (Mew Details) 8 F F 8T 4R 15
(PDF #%:0 &

T4 THAERETEY, HRFRESE (System) > % (Monitoring) > 84 (Audit), &5 il FlexConfig it
% (FlexConfig Migration) ¥4 & .
SIS LHF FlexConfig IAM T, WHLIERS (System) > ¥53% (Monitoring) > B#% (Audit), K5 riili
FlexConfig iL# (FlexConfig Migration) i1 5. ZAFCHEMITHERE, H N diRE (Report) Eltz.
TR (X NIRE (RE) (Device[Edit]) > B&E (Routing) T il H 4 IE CLTAS I L A BEE .
WIRT P FlexConfig H MR B £ HURF € RSB &, 16 R B B OPAT LR #R4E:
a) M B Y AT FlexConfig i .
b) A#H & LTI B #E FlexConfig 5 A HIA
c) MEHIH FlexConfig e B3t ) CLI X 42
d) K vees KIKHI S 1) FlexConfig SR o

SR8 (RAFIF A HACE .

FlexConfig B9/ 10 %

In =K EE =K B |1EE

Hul gl
Firepower 1000/2100 £l | 7.4.1 74.1 TR R 5, RGEIAE A TR I Bl P i gk, A2
Firepower 4100/9300 [f] BE e . B R IR EHT N4, Snort MIILAD LA UER 45 B
B~ e O Bz
FEHI R

(HIZ,  WR A TR AE AR Sh Y a5t B2 K JREA L 1) I 2/
HOBT R S, IXAT B T8 o b B OB I B AR A

BROATE LT, B s AT R e 22 Ja e T e

B A5 EKICLI fiv4:  data-plane quick-reload. no data-plane
quick-reload. show data-plane quick-reload status

YHFIMFS: Firepower 4100/9300. Firepower 4100/9300
AT ASCHRZ TR

152 Cisco Secure Firewall Threat Defense 1742 % Fll Cisco Secure
Firewall ASA R4li45% .,

FlexConfig SRA% .


https://www.cisco.com/c/en/us/td/docs/security/firepower/command_ref/b_Command_Reference_for_Firepower_Threat_Defense.html
https://www.cisco.com/c/en/us/support/security/adaptive-security-appliance-asa-software/products-command-reference-list.html
https://www.cisco.com/c/en/us/support/security/adaptive-security-appliance-asa-software/products-command-reference-list.html

. FlexConfig B9 /A 1237

FlexConfig 8% |

Ihe =K B |RIK B |iFE
s R i
W T RH. 7.3.0 D=3 SIN T XPF Flex BL & ) ECMP. VXLAN Fl EIGRP S Mg 1T % 2145 B rpuey
(152 FE o
B AE T B S R (Devices) > FlexConfig> iE#% FlexConfig (Migrate
FlexConfig)
MB% FlexConfig H1fy | 7.3.0 Ey FIN TN FLRAE A B rp P SR G BFD SR 130 HF . Rk, H
BFD [t Tl & EIGRP 0% ) FlexConfig 377 O M4 .
MR SE A7 . 7.2.5 7.2.5 TR 7 A B 7 480 h T A S8 S A A ) S
& FlexConfig H1ffy  |7.2.0 D=3 FIN TR AR A0 S G B EIGRP (132 FE. Rk, T
EIGRP it ' . # EIGRP S04 ) FlexConfig 7 CL MR «
M PBR L 7.1.0 7.1.0 YEFEAEAE FMC T A _ERCE PBR. K, 4 FTD 7.1 M A
fi & PBR [f] FlexConfig 37 £ T4 M .
Bria A& T4 . policy-route route-maproutemap-object-name.
7t FlexConfig I |7.1.0 o= I T X FLEAE FMC D ST G E ECMP XRS50 kF . Rk, T
ECMP X il i S 5 o fiil & ECMP [X I8 /] FlexConfig 3 ¥ CL IR «
1% T ISA 3000 ¥ 451 [ 6.5.0 I3 A LU F FlexConfig 7F ISA 3000 # I FC B RE 6 If [] Hpis (PTP). PTP
K& ) 3L (PTP) il e PR D L, FH T e 1) Do 86 o )20 5 A 1 45 P
B Bho AZPMNE R Tl P4 R R SR ¥
MAE, FATAVFLE FlexConfig XL ptp (B2 A0 dr & F14 )5
T4 ptp mode e2etransparent il ptp domain
BrME ST 4. show ptp.
#H i) FlexConfig %} |6.3.0 (A=) 76 LAHT (P BAS 748 FlexConfig FiC & ¥ J LA B BE 404> LU FMC H H $2

%

YFF. W IEAEAT]IX 2 FlexConfig %, #8752 HMER, SRR
BTN . LR 2 5 H K FlexConfig X GHISCAR %

* Default_DNS_Configure, 4% defaultDNSNameServerList £/l
defaultDNSParameters SCAK . AL, 4 -6 3 B R 0E A 2K
i #% L& DNS.

* TCP_Embryonic_Conn_Limit, Pl tcp conn misc #1tcp conn_limit
AN G . 76 FTD JIR55 sms h i B IX Le D fg, 0] LAAE /3 BLgs s
7 [l 2 SRS ) “ 2" (Advanced) B3R EFEEIZ R .

* TCP_Embryonic_Conn_Timeout, PLX tcp conn misc
tep_conn_timeout SLAX 4. 7E FTD A4 Sl Hh e B IX e fE .

. FlexConfig SRHE&
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FlexConfig 8971 £i2F .

=Kk &8

il

&AK B

R 1

FIE

FlexConfig 5 #T .

6.2.1

=

MRIGBUFAIEZESR, . RGP Ut P ulH 7 € L FlexConfig
X5 B T AT S0 R A NLAE s A RN EABR ik . R FTD 5T A
A 6.2.1+ J5, FlexConfig X 5 H (1 i A BUAE B S e o0 s AR
1%

BeA, T LA R i FlexConfig FiAR :
* Default_DNS_Configurefiti ik 45 g 4% 1 H BRA DNS 41, LMER T
AT I o b DR T A2 BRI i & BRI RE R EALA .
* TCP #JHA 1% 3 R 1 FA &8 Bt e B A L1 188 B8 IiC B 4] 334 2 B ol
I CLI, PABfik SYN 23t DoSAH ;.
* 3 F ARG T L B FRSE BRI L 85 BE A TCP 424 1 SOk i v s
JAS I SRS & o

* IPV6 B 25 4R kA M A L R REIC & TPV KR Sk, DAE kbt
Hi AP RSN R RSk (it SSFRH2EHI 2. B3

» DHCPV6 BB I IE & HE R IPv6 RTZFZALE — NS (PD
P AN D (BERRGT S ek E) .

FlexConfig.

6.2.0

(=S

FlexConfig Dy fig ik #E fe{li F FMC KT ASA CLI [ Dl fie 8 21 FTD &
o WLIIREAVFE S H FTD B4 12 AT i) — 285 AN ASA
Difie. Wb RERE 25 ha A A 70 HEms h b ) AR RSN 5. SR} TAC
IE S BRI .
HTHG G R B

* & % > FlexConfig

* 3% (Objects) > R &I (Object Management) > FlexConfig >
FlexConfig 3% (FlexConfig Objects)

* X% (Objects) > 3 KR EIE (Object Management) > FlexConfig > 3Z
ARFH & (Text Object)

FlexConfig SRA% .
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. FlexConfig A1 5E 23R
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